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CHAPTER 1: 

INTRODUCING THE NORTHEAST MEGAREGION TRAVEL 

DEMAND AND INVESTMENT (NEMR TD&I) MODEL 

1.1 OVERVIEW OF THE NORTHEAST MEGAREGION TRAVEL DEMAND & 

INVESTMENT (NEMR TD&I) MODEL 

The Northeast Megaregion Travel Demand and Investment (NEMR TD&I) Model is a standard 4-

step travel demand model that brings together population and job forecasts for 2030 and 2040 with 

detailed highway and public transportation network data across the 13-state Northeast Megaregion 

to help transportation planners evaluate the demand for new transportation facilities and services. 

Implemented using TransCAD, a widely-used PC-based transportation planning package that 

combines a map-based interface with cutting-edge travel demand forecasting procedures, the 

NEMR TD&I Model functions at two spatial scales: (i) the megaregional scale, spanning 

counties along the I-95 corridor from Maine to Virginia; and (ii) the multi-metropolitan area 

scale, based on zip code districts for the combined Boston-Providence-Worcester region, the 

Greater New York City region, the Greater Philadelphia region, and the Baltimore-

WashingtonRichmond metro area clusters. 

The NEMR TD&I Model is written in GISDK, TransCAD’s scripting language and runs on any 

PC with TransCAD is installed. In addition to travel demand modeling scripts and procedures, 

the NEMR TD&I Model brings together all the input data required to conduct a comprehensive 

4-step travel demand analysis, including alternative 2030 and 2040 population and job forecasts 

by county and zip code district grouping; a detailed highway network that includes major and 

minor roads; rail, subway and bus networks for each metropolitan area constructed from open-

source General Transit Feed Specification (GTFS) data; and baseline mode share percentages 

drawn from the 2017 National Household Transportation Survey (NHTS) and local MPO travel 

demand surveys. The NEMR TD&I also includes options to help users enter their own forecasts, 

network data, and mode share information. The NEMR TD&I Model is also the only urban 

forecasting model to give users the option of combining truck and private automobile trips on the 

same roadways. 

1 
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NEMR Characteristics & Transportation Facilities 

NEMR Share of 

Total US Total 

NEMR States (all or part) 

NEMR Counties 

NEMR Metropolitan Planning Organizations 

13 25% 

152 5% 

46 11% 

2015 Population (millions) 

2015 Employment (millions) 

54.4 17% 

22.5 15% 

Miles of Interstate Highway 

Miles of 4-lane Highway 

Share of 25 Most Congested Highway Hotspots 

3,679 8% 

8,832 10% 

28% 

Urban Rapid Transit (URT) Systems 

URT Track Length (miles) 

URT Stations 

URT Ridership (2018, billions of passengers) 

8 53% 

494 60% 

753 71% 

3.2 86% 

Public Airports 

Commercial Airports 

Share of 30 Largest U.S. Airports 

2017 Airport Passengers (millions) 

146 3% 

37 7% 

27% 

136 22% 

Major Cargo Seaports 

Cargo Volume (millions of short tons) 

14 14% 

290 12% 
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1.2 WHY WE DEVELOPED THE NEMR TD&I MODEL & WHO SHOULD USE IT 

Multi-jurisdictional transportation planning efforts in the U.S. are currently undertaken at the 

state and metropolitan level. This arrangement works well enough in some regions but not in the 

Northeast, where 13 states and nearly 50 Metropolitan Planning Organizations (MPOs) share a 

complex multi-modal transportation system serving more than 50 million residents and 22 

million jobs. We developed the NEMR TD&I Model to help transportation planners 

collaborating across states and metropolitan areas better evaluate how future changes in 

population and jobs will shape the future demand for transportation infrastructure and services. 

Based on the widely-used 4-Step transportation planning model and bringing together detailed 

information on highways and public transportation networks, the NEMR TD&I Model is 

intended for use by a broad spectrum of transportation stakeholders including state, regional, 

metropolitan and city transportation planners; transportation decision-makers and funders 

looking to make sure proposed projects and investments respond to real transportation needs; 

highway engineers and transit system operators seeking to understand how new facilities and 

services will affect modal use patterns, congestion levels, and transit ridership; and advocacy 
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groups and entrepreneurs concerned with improving mobility levels for all metropolitan and city 

residents. 

Potential users of the NEMR TD&I Model should have a general familiarity with the 4-step 

travel demand modeling process and a working knowledge and legally-installed copy of 

TransCAD. 

1.3 WHAT IS THE NEMR TD&I MODEL GOOD FOR? 

The NEMR TD&I Model is designed to help regional transportation planners evaluate the 

metropolitan-level transportation demand and service implications of different population and 

job projections; to help state and metropolitan planners coordinate their transportation analysis 

and modeling work across multiple metropolitan areas; to help public transit operators 

understand where their services are most competitive; and to help local stakeholder groups 

identify transportation service equity and performance issues. By including all the input data 

needed to run a 4-step travel demand model, the NEMR TD&I also serves as a convenient 

stepping-off point for transportation planners and others looking to incorporate new forecasts, 

new methods and new transportation service data into their work without having to create new 

transportation networks and demand forecasts from scratch. Lastly, the NEMR TD&I Model is 

intended as an education tool to help future generations of transportation planners, engineers and 

entrepreneurs understand why multi-modal urban transportation systems perform the way they 

do and how they can be made to work better. 

1.4 HOW THE NEMR TD&I MODEL WORKS 

The NEMR TD&I Model runs as series of GISDK scripting tabs that progress through the 

standard 4-step travel demand model procedures including: (i) Trip Generation, which converts 

future population and job projections into trip productions and attractions; (ii) Shortest Path and 

Trip Distribution, which coverts trip productions and attractions into a trip table of complete 

trips (by purpose) between every trip origin and destination zone; (iii) Mode Share Analysis, 

which identifies the share and number of trips using each competing mode; and Traffic and 

Route Assignment, which assigns each set of modal trips to the appropriate highway or transit 

routes. 

4. Traffic & Route 

Assignment 
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Population & 

Job Forecasts 

1. Trip Generation 

Analysis 

2. Trip 

Distribution 

Analysis 

3. Mode 

Share 

Analysis Users begin a 

NEMR TD&I Model run by choosing either the entire Northeast Megaregion or a metro area 

cluster (MAC) as the study area for their analysis, and choosing a population and job forecasting 

method and year. If they wish, users can also input their own forecasts. The results of every step 

in the NEMR TD&I Model are automatically used as the input into the subsequent step, 

however users are also given the option of saving and inputting their own intermediate files and 

data tables. The task of dividing the table of future trips into its modal components is 

accomplished using a mode share percentage table drawn from the results of local travel demand 

surveys conducted by the appropriate metropolitan planning organization. Users can adjust these 

mode share percentages up or down to simulate modal different scenarios, as well as use their 

own mode share percentages. The result of a NEMR TD&I model run is an assignment of modal 

trips to the appropriate highway or transit routes. . The modal assignment results can be further 

displayed and analyzed in TransCAD’s map window. Once the traffic and route assignment step 

has been completed, users can go back to ay previous step to build a new scenario or trip table. 

Boston Metro Area Cluster 

Boston 

Newark NY City 

New York City Metro Area Cluster 

Philadelphia Metro Area Cluster 
Baltimore 

5 
Philadelphia 



  

        
 

 

      

   
 

        
 

        

 
 

      
 

        
 

        
 

         
 

         
 

 
 

          
 

         

            

        

      

          

   

 
 
 

  
 

        
 
 
 
 

       

       

       

          

           

       

1.5 WHAT’S DIFFERENT ABOUT THE NEMR TD&I MODEL? 

Compared to most conventional 4-step travel demand models, the NEMR TD&I Model offers 

several unique features, including: 

• It can be run at both the megaregional and multi-metropolitan area level. 

• It includes population and job projections for 2030 and 2040 based on alternative growth 

assumptions. 

• It incorporates both inter-city and metropolitan level rail and bus service. 

• It uses mode share percentages drawn from local travel surveys. 

• It can combine auto trips with truck trips based on national freight flow data. 

• It makes use of open-source GTFS data describing local public transit services. 

• It allows users to modify or insert their own data inputs at every step. 

1.6 GETTING STARTED USING THE NEMR TD&I MODEL AND DATA 

To get started using the NEMR TD&I Model, download the model User’s Manual and skim 

Chapters 1-4. Then go to the Download Center of the NEMR TD&I website and download the 

model and input data to your local hard drive. Follow the directions in Chapter 3 of the User’s 

Manual about setting up the appropriate directory structures. Start TransCAD and make sure it 

recognizes the NEMR TD&I Model script, which is written in GISDK. Then click on the 

opening “Getting Started” menu tab. 

CHAPTER 2: 

LOGIC & ORGANIZATION OF THE NEMR TD&I MODEL 

The Northeast Megaregion Travel Demand & Investment Model (NEMR TD&I Model) is a 

traditional 4-step (Trip Generation, Trip Distribution, Mode Share, Route Assignment) travel 

demand model that converts population and job projections into future trips between a series of 

origin and destination zones, divides those trips by mode (e.g., drive, commuter rail, subway, 

bus, walk), and then allocates the resulting modal trips to highway and transit routes. The 

NEMR TD&I Model runs on top of TransCAD, a widely-used desktop travel demand modeling 

6 



  

      

   
 

 

         

     

 
          

        

  
 

      

       

      
 

         

    
 

               

        
 

          

   
 

          

   
 

          

   

 
           

     

package, using a series of pre-organized datasets and custom-designed scripts written in GISDK, 

TransCAD’s built-in scripting language. 

The NEMR TD&I offers a number of useful features compared to travel demand models used by 

metropolitan planning organizations (MPOs). These include: 

• It covers the entire Northeast Megaregion (NEMR) from Portland (Maine), down through 

Boston, Providence, Hartford, New York City, Philadelphia, Baltimore, Washington D.C., 

and Richmond metropolitan areas. 

• It operates at two spatial scales, the afore-mentioned Northeast Megaregional (NEMR) 

scale; and the Metropolitan Area Cluster (MAC) scale, which includes clusters of 

metropolitan areas around Boston, New York City, Philadelphia, and Washington, D.C. 

• It makes use of a series of common population and job projections for 2030 and 2040 

based on forecasts produced by state planning departments. 

• It makes use of mode share percentages (e.g., the share of trips between a particular origin 

and destination pair using a particular mode) using survey data collected by local MPOs. 

• It makes use of rail and bus networks generated using the industry-standard General 

Transit Feed Specification (GTFS) standard. 

• It gives the users the option of incorporating truck trips as estimated using the Federal 

Highway Administration’s Freight Analysis Framework (FAF) Model. 

• It allows users to quickly update their input assumptions and to graphically compare the 

results of different scenarios 

• It provides a series of convenient entry points for users to add their own population and 

job projections and mode share estimates. 

7 



  

       
 

 

    

         

       

          

       

 
        

           

    

 
 

              

           
 

 
 
 

          

        

     

        

      

           

        

           

   

         

           

      

 
 
 

             

           

           
 
 

          

         

     

2.1 A PRIMER ON 4-STEP TRAVEL DEMAND MODELS 

Four-step travel demand models convert externally-generated population and employment 

projections to a trip table (a square-shaped table of trips between origin and destination zones) 

and then to modal trip tables which are then allocated to particular roads and routes. As 

presented below and shown in EXHIBIT 2A, each of the four steps in the model uses its own set 

of modeling procedures and algorithms to generate its results: 

2.1.1 Travel Analysis Zones: Travel analysis zones (TAZs) are aggregations of census 

tracts, zip code districts, or other census geographies that serve as trip origin and 

destination “catchment” areas for tabulating trip-making activity. 

► The NEMR TD&I Model uses two types of TAZs: Superzone TAZ (STAZs), which consist of single or 

multiple counties; and MAC TAZs (MTAZs), which consist of combinations of zip code districts. 

2.1.2 Networks: Networks consist of collections of links and nodes that allow trip-

makers and/or vehicles to travel from an origin location or zone to a destination 

location or zone. Common transportation networks include highway networks, 

commuter rail networks, subway and lightrail networks, and bus networks. Each 

network link includes information on its physical length and permissible travel 

speed, or, in the case of transit networks, vehicle schedules. Each node includes 

information on which links it connects, and which link-to-link transfers are 

allowed. Centroids are a special class of nodes located at the center of TAZs. Once 

a network has been 

“built,” travelers can use it to travel from connected origin zones to connected destination zones 

regardless of the distance or time between them. Highway networks can be connected to transit 

networks, making it possible to transfer between modes. 

► The NEMR TD&I Model makes use of FHWA’s national road network as the basis for its highway 

network, and metro area-level commuter rail, subway, light-rail, and bus networks which are 

provided in open-source form using the General Transit Feed Specification (GTFS) format. 

2.1.3 Step 1: Trip Generation: Trip generation is the first step in the standard 4-step 

travel demand model. Trip generation procedures use statistical models or census-

based trip generation rates to convert population and employment projections to 

8 



  

         

           

       

     

     

     

       

          

        

       

      

    

   
 

 
 

           

           

 

           

  
 

 
 
 

          

     

          

         

      

            

              

          

       

           

       

       

trip productions and attractions by purpose and zone. Trip productions are the 

beginning points of trips such as homes. Trip attractions are the ending points of 

trips such as work, shopping, school, or visiting friends. Common trip purposes 

include home-based work (where trips are produced from homes and attracted to 

work locations); home-based shopping (where trips are produced from homes and 

attracted to shopping or retail activities); home-based other (where people travel 

from home to personal business or recreational activities), and non-home-based 

(where people begin a trip from a location that is not their home). All home-based 

trips have an outbound leg and a return leg. Trip generation models use either 

regression models or standardized rates to convert population and household counts 

(disaggregated by income group or household type or household auto ownership 

levels) to home-based productions; and employment counts (disaggregated by 

business type) to work and shopping attractions. 

► The NEMR TD&I Model makes use of three trip purposes (home-based work, home-based 

other, and non-home-based) and purpose-specific trip generation rates as published in the 

National 

Cooperative Highway Research Project’s (NCHRP) Report 365: Travel Estimation Techniques for 

Urban Planning 

2.1.4 Step 2: Trip Distribution: The second step in the standard 4-Step model, Trip 

Distribution converts zonal-based lists of trip productions and attractions (by 

purpose) as produced in the trip generation step into a single trip table, a square 

matrix of trips from each TAZ origin zone to each TAZ destination zone. Trip 

distribution is usually undertaken as a two-step process. The 

first step is the production of “minimum path skim trees.” These are particular combinations of 

highway or transit network links and nodes which deliver a traveler going from a specific origin 

zone to a specific destination zone in the minimum time or distance. Each origin-destination 

zone combination (O-D couple) has a single minimum-time or minimum-distance highway 

and/or transit path, although not every O-D couple is connected via transit. The second Trip 

Distribution step uses the minimum paths generated in the first step and some form of spatial 

interaction algorithm to convert productions and attractions into trips. The most widely-used 

9 



  

              

 
 

 
 
 

        

       

     

   

 
 

           

       

      

 

 
 

             

            

            

           

         

             

  
 
 
 

        

       

        

    
 

 
 

           

             

              

 

► The NEMR TD&I Model makes use of TransCAD’s default minimum time path and gravity model 

algorithms. 

spatial interaction algorithm is known as the “gravity model.” Like its physical namesake, travel 

gravity models distribute trips to origin-destination couples based on the level of activity 

(productions and attractions) at each origin and destination zone; and at the difficult of traveling 

between those zones based on the estimated minimum paths. 

2.1.5 Step 3: Mode Share Analysis: The third step in the standard 4-Step model, Mode 

Share Analysis divides the single trip table produced in the Trip Distribution step 

into multiple trip tables by mode based on observed survey data or the results of 

statistical models. 

► For the full Northeast Megaregion study area, the NEMR TD&I Model uses mode share 

percentages (e.g., percentage of travelers who drive, or take commuter rail, subway, or bus, or 

who walk or ride a bike) tabulated from the 2017 National Household Travel Survey (NHTS). For 

the four Metro Area Cluster (MAC) models, the NEMR TD&I Model uses mode share percentages 

tabulated from travel surveys conducted by individual MPOs. Depending on the particular 

survey, these tabulations list mode share by trip purpose, trip length, and type and location of 

trip origin. 

2.1.6 Step 4: Route Assignment: The final step in the standard 4-Step model, Route 

Assignment assigns modal trip volumes (as generated in the Mode Share Analysis step, above) 

to particular highway or transit routes based on minimum travel time and available vehicle 

capacity or transit vehicle schedules. 

► The NEMR TD&I Model makes use of TransCAD’s default route assignment procedures which 

incrementally assign trips or vehicles to routes based on minimum travel time subject to the 

amount of remaining vehicle capacity. These route volumes can be displayed graphically of in list 

form. 

10 
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Exhibit 2A: Structure & Logic of the NEMR TD&I Model 

Full Megaregional Boston- Greater Baltimore-

Greater 

(FMR) Model Providence- New York Washington-

Study Area ► Philadelphia 

spanning 13-state Worcester City MAC Richmond MAC 

MAC Model 

Study Area MAC Model Model Model 

▼ ▼ ▼ ▼ ▼ 

A. Model Setup Activities: Identify Traffic Analysis Zones (TAZs) and Build Highway and Transit 

Networks. 

Identify Traffic 

Analysis Zones 

(TAZs) based 

on: 

County-based 

Superzone TAZs 

(STAZs) 

MAC traffic analysis zones (MTAZs) based on combinations of 

zip code districts 

Build Modal 

Networks 

Build highway and 

intercity rail 

networks 

Build highway network. Use GTFS data to build commuter rail, 

subway & trolley & local bus networks as appropriate 

B. Four-Step Travel Demand Modeling 

Step 1: Trip 

Generation 

Generate trip 

productions and 

attractions (Ps & As) 

by trip purpose and 

county 

Generate trip productions and attractions (Ps & As) by trip 

purpose and county 

Step 2: Trip 

Distribution 

Generate trip tables 

(by purpose) using 

minimum path 

times and gravity 

model 

Generate trip tables (by purpose) using minimum path times 

and gravity model 

Step 3: Mode 

Share Analysis 

Use distance-based 

mode share 

percentages from 

2017 National 

Household Travel 

Survey 

Use zonal-type and distance-based mode share percentages 

from local MPO travel demand surveys 
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All-or-nothing 

Step 4: Traffic highway and All-or-nothing highway, commuter rail, subway, and local bus 

Assignment intercity rail route route assignments 

assignments 

2.2 TWO MODELING GEOGRAPHIES 

The NEMR TD&I Model operates at two geographic scales. The first is the megaregional scale 

which spans the full Northeast Megaregion from Portland (Maine) to Richmond ( Virginia). The 

Full Megaregional Model (FMR Model) uses counties as its traffic analysis zones (TAZs); is 

limited to analyzing roadway and inter-city rail service; and uses mode share percentages 

calculated from the 2017 National Household Transportation Survey (NHTS). 

The FMR Model is meant to be used by transportation planners and decisionmakers who want to 

understand how big transportation investments or service changes undertaken in one part of the 

NEMR will likely affect travel behavior and travel patterns in other parts of the NEMR. 

Situations where planners would want to use the FMR Model could include upgrading existing 

Northeast Corridor regional rail service to a high-speed rail service or building a new rail tunnel 

under the Hudson River between Manhattan and New Jersey or adding additional freeway 

capacity between Baltimore and Richmond. The effects of each of these investments on travel 

patterns and traffic would be felt far beyond the specific counties or even metropolitan areas 

where they occur. Fully understanding the magnitude and spatial extent of those effects requires 

having a modeling and forecasting system whose coverage goes well beyond existing MPO and 

state boundaries. Exhibit 2B identifies the spatial extent of the Full Megaregional Model. 

The second scale at which the NEMR TD&I Model operates is the multi-metro area scale. This 

scale joins adjacent metropolitan areas into four clusters (MACs) served by common roadway or 

rail corridors. The four MAC Models uses combinations of zip code districts as their traffic 

analysis zones (TAZs) and make use of MPO travel survey data as the basis of their mode share 

calculations. In addition to highway and commuter rail travel, the MAC models incorporate 

travel by subway and light-rail, and local bus service. The four MAC Models include: 

• The Boston-Providence-Worcester Cluster (BPW MAC) which extends from the Boston suburbs 

in the north to Providence County (Rhode Island) in the south to Worcester County 

(Massachusetts) in the west; The BPW MAC includes 14 counties and 144 zip code-based TAZs. 

• The Greater New York City Cluster (NYC MAC) which includes the five boroughs of New 

York City plus Fairfield County in Connecticut, Westchester, Putnam, Rockland, and 



 

     

            

 
 

 
 

 
 

 

          

       

           

        
 

       

    

        

     

       

         

   

13 

Nassau and Suffolk Counties in New York State, and Bergen, Passaic, Hudson, Essex, 

Union, and Somerset Counties in New Jersey. The NYC MAC includes 21 counties and 

271 zip code-based TAZs. 

• The Greater Philadelphia Cluster (PHILLY MAC) which centers on Philadelphia and extends 

from Mercer County (New Jersey) in the north to Camden and Burlington County (New Jersey) 

in the east to New Castle County (Delaware) in the south, to Chester County (Pennsylvania) in 

the west. The PHILLY MAC includes 13 counties and 140 zip codebased TAZs. 

• The Baltimore-Washington DC-Richmond Corridor Cluster (BDCR MAC) which follows 

Interstate 95 south from Baltimore County through Washington D.C.’s Maryland and 

Virginia suburbs to Richmond and Henrico County (Virginia) in the south. The BDCR 

MAC spans 39 counties and 207 zip code-based TAZs. 

Exhibit 2C identifies the four MAC study areas. 

Exhibit 2D summarizes the key operational differences between the Full Megaregion Model and 

the four MAC Models. 
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Exhibit 2c: NEMR TD& I Model Metro Area Cluster Traff ic 

Ana lysis Zones{MTAZs) 



  

           Exhibit 2D: Comparing the Full Megaregion (FMR) and Metro Area Cluster (MAC) Models 
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Model Type & Scale ► 
Full Megaregional (FMR) Model 

Metro Area Cluster (MAC) Models 

Geographical Coverage ► 
17 

4 separate metro area clusters (Boston, 
13-state Northeast New York City, Philadelphia, 

Megaregion Washington DC) 

Traffic Analysis 

Zones (TAZs) 

based on: 

Combinations of zip code districts (MAC TAZs 
Counties (Super-TAZs, or STAZs) 

or MTAZs) 

Model Modal 

Setup Networks 

Activities 

Highways and Inter-city rail Highways, regional and commuter rail, 

only subways, metropolitan and urban bus 

Forecasting 

Geographies 

Step 1: Trip 

Generation 

County-based population 

and job projections 

Uses NCRP 365 trip generation 

rates to generate trip 

productions and 

attractions by purpose & 

STAZ 

County-level projection and job 

projections are disaggregated to the zip-

code-based MTAZ level 

Uses NCRP 365 trip generation rates to 

generate trip productions and attractions by 

purpose & MTAZ 

Calculates highwaybased 

Calculate minimum travel times Calculates highway-based minimum travel 

Minimum Path between each times between each origindestination 

Times origin-destination STAZ MTAZ pair 
pair 

Generate trip tables (by purpose) 
Generate trip tables (by purpose) using

Step 2: Trip using STAZ-
MTAZ-based minimum path times and 

Four-Step 

Travel Distribution based minimum path times 
gravity modelDemand and gravity model 

Modeling 
Use distance-based 

Use zonal-type and distance-based mode 
Step 3: Mode mode share percentages 

share percentages from local 
Share Analysis from 2017 National 

MPO travel demand surveys
Household Travel Survey 

All-or-nothing highway All-or-nothing highway, commuter rail, 
Step 4: Traffic 

and intercity rail route subway, and local bus route 
Assignment 

assignments assignments 

Add in truck trips generated 
Truck Traffic from 
Assignment II modified FAF4.1 freight 
(Optional) flows 

Similar approaches for both scales: (i) Alternative population and job forecasts; 

Scenario Building Approaches (ii) User-specified alternative mode share percentages; (iii)user-specified 

changes to highway or rail network to incorporate changes in service 



  

      
 

 

       

            

     

 
          

        

           

             

         

              

         

         
 

      

           

           

    
 

         

          

          

            

        

        

   

 

          

                  

                 

              

 

          
 

    

       
 

         

            

2.3 ALTERNATIVE POPULATION AND EMPLOYMENT PROJECTIONS 

To help ensure that the megaregional forecasting process is consistent across the 13 states and 20 metro areas in the 

NEMR study area, the NEMR TD&I Model comes pre-packaged with three sets of 2030 and 2040 population and 

employment projections. The three sets include: 

1. State-generated Forecasts and Projections: This set of projections starts with 2030 and 2040 state- and county-

level population projections as generated by each state’s planning department, data center, or other applicable 

agency; and with 2015 state and county job counts as identified in the Census Bureau’s County Business Patterns 

database. To convert the 2030 and 2040 population projections to 2030 and 2040 job projections, the former are 

divided by the applicable state or county population-to-job ratio as of 2015. To account for expected increases in 

labor force participation rates, the 2030 state-level population-to-jobs ratio is reduced by 0.1 over the 2015 ratio, 

and the 2040 ratio is reduced by another 0.1 over the 2030 ratio. These upward-adjusted state employment 

projections are then used as control totals to adjust the 2030 and 2040 county-level job projections. 

2. County Growth Trend Projections: This method assumes that recent county-level population and employment 

trends will continue indefinitely into the future. In terms of population projections, it first calculates annualized 

rates of county population change between 2000 and 2018 and compounds them forward by 12 and 22 years 

respectively to generate 2030 and 2040 county population estimates. 

These county-level estimates are then adjusted upward or downward so that they sum to the state projections. 

Similarly, in terms of employment projections, we first calculate annualized rates of county employment change 

between 2012 and 2018, and then use those job growth rates to generate 2030 and 2040 job projections. Because 

the 2012-2018 period was one of atypically sustained job growth, we impose categorical limits of +1% and -1% 

on each county’s annualized job growth rate. The resulting state-level job projections are cross-checked for 

reasonableness with the 2015 population-to-job ratios used in the prior method, and then used as control totals to 

adjust the county-level job projections accordingly. 

3. State Share Trend Projections: This method assumes that recent county population and job 

share trends will continue into the future. For example, if a county’s share of its state’s population fell from 12% 

in 2000 to 10% in 2018 and the trend continues, its 2030 population share will be 8.67% (10% - [12 years * -

.11% annual share change]) while its 2040 population share will be 7.56% (10% - [22 years * -.11% annual share 

change]). 

These annual share trend rates are used to generate 2030 and 2040 county population and 

job estimates, which are then adjusted upward or downward so that they sum to the statelevel population and 

job projections generated in the state forecasting method described earlier. 

4. User Projections: This option allows for user flexibility in incorporating alternative population and job shared 

trends/assumptions. By utilizing the Projections Editor script, the user will have the ability to export and 
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recombine the provided projection databases, allowing for alternative analysis. Exhibit 2E below summarizes the 

key differences between the three projections series. 
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Table 2E: Population and Job Projection Method Comparisons 

State-generated County Growth Trend 

Projections Projections 

State Share Trend 

Projections 



 

 

 
 

  

 

  

 

 

 

 

   
             

 

 
 
 
 
 
 

 

   

   

  

 

 

   

 

 

   

  

  

    
 

 
          

 
 

               

    
 

 

 

  

  

   

 

   

 

 
    

      
 

    

     

 

 

 

 

    

   

   

  

 
 

 

    
 

 
  

 

 

   
 

 
    

  

 

   

 

  

   

 

 

 

  

 

          

           

   
 

    
 

 

           

         

             
 

 

edded 

ions 

n 

High-quality state 

forecasts; no big 

shifts in population-

to-job ratios or TAZto-

county ratios 

Current county-based 

population growth trends Current county 
continue population share trends 

through 2040; no big shifts continue through 2040; no 
in current big shifts in current 

population-to-job population-to-job ratios or 
ratios or TAZ-to-county TAZ-to-county ratios 

ratios 

hy Counties Counties Counties 

Years 2030 & 2040 2030 & 2040 2030 & 2040 

2000 and 2018 Census and 2002 and 2018 Census and State planning and on Data 
finance agencies ACS estimates ACS estimates 

Job 2018 County 

rces Business Patterns 

2018 County Business 2018 County Business 

Patterns Patterns 

Relies on county 

population 
on Projection 

projections 

generated by state 

agencies 

on 
Yes Total 

Extends 2018 

countybased jobs-to-

ection population ratios, with 

gradual 

Extends each county's 
Extends each county's 

2000-2018 (annualized) 
2000-2018 share of state 

growth rate, subject to 
population growth 

1% annual limit 

Yes Yes 

Extends 2018 
Extends 2018 countybased 

countybased jobs-to-
jobs-to-

population ratios, with 
population ratios, with 

gradual 

convergence to state 
gradual convergence to state 

convergence to state 
ratio. 

ratio. ratio. 

ation to 2018 Population and 2018 Population and 
2018 Population and Jobdel TAZs Job MTAZ-to-County Job MTAZ-to-County Ratio 
MTAZ-to-County RatioRatio 

2.4 MPO-BASED MODE SHARE PERCENTAGES 

The usual approach to mode share or mode choice analysis is to use travel survey information to build a 

statistical model that relates traveler characteristics and modal level of service measures to the share of 

zonal trips using each competing mode, or to the choice of mode for a particular trip destination and 
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purpose. This approach is very data intensive and works well when all the travelers in a particular study 

region have the same choices among modes. It is less useful, as in the current case, when the choice of 

modes varies between metro areas or even within metro areas. For this reason, instead of building a 

statistical model, we applied existing mode share percentage as derived from the results of locally-

appropriate travel demand surveys. In the case of the Full Megaregion Model (FM), we calculated mode 

share percentages from the 2017 National Household Travel Survey as tabulated by origin metro area, 

trip length, and trip purpose. 

For the four Metro Area Cluster (MAC) models, instead of using NHTS tabulations, we used tabulations 

and mode share percentages derived from local MPO travel demand surveys. These included the 2011 

Massachusetts Travel Demand Survey, which was administered for the Boston region by the Boston 

Region Metropolitan Planning Organization; the 2010-2011 New York Regional Household Travel Sur 

vey (covering parts of New York, New Jersey and Connecticut) conducted by the New York 

Metropolitan Transportation Council; the 2012-2013 Delaware Valley Regional Travel Survey (covering 

parts of Pennsylvania, New Jersey and Delaware) conducted by the Delaware Valley Regional Planning 

Commission; and the 2007/2008 TPB 

Household Travel Survey (covering Washington DC, Baltimore, and parts of Maryland and Northern 

Virginia) by the National Capital Region Transportation Planning Board. Each of these agencies uses its 

own surveying frames and formats, making it difficult to directly compare the results of one survey to 

another. This limitation notwithstanding, planners can use the individual surveys to see how the use of 

various travel modes varies within each MAC region by trip purpose, origin area or type, and trip 

distance. 

NEMR TD&I Model users can use the various survey-based mode share percentages as is, or they can 

vary them in a manner consistent with proposed transportation facility investments or level of service 

changes. Suppose, for example, that Boston were to build a connector link 

between North Station and South Station enabling commuter rail travelers coming from Boston’s 

southern suburbs via South Station to continue on directly—something they cannot currently do—to 

North Station, which serves Boston’s northern suburbs. This improvement in commuter rail service could 

be simulated by increasing commuter rail’s current mode share for medium-

distance Boston area work trip from its current level of 3-7% (depending on the purpose) up to 4-

8% to reflect commuter rail’s improved modal attractiveness. 

Exhibit 2F summarizes the major differences between the 2017 National Household Travel Survey (NHTS) and the 

four MPO-based travel surveys. 
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Table 2F: Sources of Mode Share Percentages Used in the NEMR TD&I Model 

BostonProvidence- Washington DC-

Study Area 

& Model 

Northeast 

Megaregion 
Worcester 

MAC Model 

Greater New 

York MAC 

Greater 

Philadelphia 
Baltimore-

Richmond MAC 
FMR Model Model MAC Model Model 

Surveying 

Organization 

Data 

Classificatio 

n System 

Major modes 

Federal 

Highway 

Administratio n 

National 

Household 

Travel Survey 

(NHTS) 

Metro area, trip 

purpose, 

travel distance 

band, top 4 

modes 

Auto driver or 

passenger, 

commuter/reg 

ional rail, 

subway, bus, 

taxi, walk & 

bike, ferry, air, 

other 

Boston Area Delaware 
New York 

trips Valley 

selected 
Metropolitan 

Regional 

from the 
Trannsportation 

Council 
Planning 

NHTS Commission 

Survey Years 2017 2017 2010-2011 2012-2013 2007-2008 

 
 

         
 

 

     

  
       

  
       

      

 

 

    

     
     

 
  

  
     

 
  

 

 
   

 
 

 

   
 

 
 

 

 

       

  

             
   

             
   

         
 

 

            

      
 

 

   
 

 
    

  

 

  

    

                   

 

 

  

  

     

 

   

  

   

  

   

 

   

 

         
         

           

     
    

     
  

 

       
  

       
  

       
 

 

       
  

       
  

  
    

   

   

       
   

   
    

     
   

        
   

       
         

       
      

        
      

     
       

  

Origin zone 

County of type (e.g., CBD, 

Trip purpose & origin, trip outer CBD, 

distance purpose, trip etc.), trip 

band, top 4 modes distance band, purpose, trip 

top 4 modes distance band, 

top 4 modes 

< 25 miles; 25-

50 miles; 50-75 

miles; 75-100 

miles; 100-150 

Trip Distance miles; 150-200 

Bands miles; 200-300 

miles; 300-500 

miles; 5001000 

miles; > 

1000 miles 

< 1 mile; 1-3 miles, 3-

5 

miles; 5-10 miles; 

10-15 miles; 15-20 

miles; 20-25 miles; 

25-30 miles; 30-40 

miles; 40-50 miles; 

50-99 

miles; 100+ miles 

< 1 mile; 1-3 
< 1 mile; 1-3 

< 1 mile; 1-3 miles, 3-5 

miles, 3-5 miles; 5-10 
miles, 3-5 miles; 5-

miles; 5-10 miles; 10-15 
10 miles; 10-15 

miles; 10-15 miles; miles; 15-20 
miles; 15-20 

15-20 miles; 20-25 miles; 20-25 
miles; 20-25 

miles; 25-30 miles; miles; 25-30 
miles; 25-30 

30-40 miles; 40-50 miles; 30-40 
miles; 30-40 

miles; 50-75 miles; miles; 40-50 
miles; 40-50 

miles; 50-75 
75+ miles miles; 50+ 

miles; 75+ miles 
il 

Auto driver or 
Auto driver or passenger, Auto driver or 

passenger, commuter/r passenger, 
commuter/regi egional rail, subway, commuter/regi 

onal rail,bus, taxi, onal rail, 
subway, inter-walk & bike, ferry, air, subway, inter-
city bus, urban other city bus, urban 

bus, school 
bus, school bus, 

bus, taxi, walk 
taxi, walk & bike 

& bike 

National Capital 

Region 

Trannsportation 

Planning Board 

County of origin, 

trip purpose, trip 

distance band, top 

4 modes 

Auto driver, auto 

passenger, 

commuter rail, 

subway, inter-city 

bus, urban bus, 

school bus, taxi, 

walk & bike, ferry 
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2.5 ADDING TRUCK TRIPS 

One of the NEMR TD&I Model’s most useful features is its ability to assign truck trips to highway links along with 

passenger vehicles. In terms of estimating the number of truck trips to be assigned, the NEMR TD&I Model makes use 

of 2012 freight flow estimates and 2030 and 

2040 freight flow projections as produced by the Federal Highway Administration’s Freight Analysis Framework, now 

in its fourth iteration and known as FAF4.1. FAF4.1 identifies U.S. goods movement flows by weight and value across 

150 national freight-analysis zones (FAZs) comprised of major metropolitan areas and non-metropolitan state 

remainders. FAF 4.1 divides these flows across seven freight modes (truck, rail, water, air, pipelines multiple modes, 

and other) and into 47 commodity types ranging from coal and petroleum products to precision instruments. Because 

FAF 4.1 operates with a different geography than the NEMR TD&I Model, identifying and incorporating FAF 4.1-

based truck flows into the NEMR TD&I Model requires a number of geographic and categorical modifications. These 

include: 

1. Aggregating FAF4.1’s freight flows based on a zonal geography that is consistent with the 

Full Megaregional Model’s county-based zones. All told, this involved collapsing FAF4.1’s 150 national freight 

zones into 29 county-based NEMR TD&I super zones. 

2. Collapsing FAF4.1’s 47 distinct commodity types into 27 commodity groups. 

3. Developing updated freight flow projections for 2030 and 2040 based on more recent economic and populations 

growth rates—FAF4.1’s projections were last updated in 2012-and using the updated zonal geographies and 

commodity categories. 

4. Separating out truck-based freight flows from other modes and parsing them into discrete truck trips based on 

commodity types and weights. 

5. Converting annual truck trips by commodity type into single-day and hourly trip volumes between NEMR TD&I 

Model zones. These single-day and time-of-day truck trips can then be assigned to the same highway links used by 

the FM and MAC Models. 

Exhibit 2G summarizes these steps in greater detail. A separate NEMR TD&I Freight Module allows users to 

interactively specify which commodity groups they wish to include in the mapped truck trip volumes as well as how 

many tons of each commodity an individual truck can carry. 
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Exhibit 2G: Converting FAF4.1 Freight Flows to NEMR TD&I Model 

Truck Trips 

Collapse 150+ FAF4.1 Freight Analysis Zones into 29 Countybased 
Step 1 Superzone TAZs (STAZ) 

Aggregate 47 FAF4.1 Commodity Types into 27 Commodity Groups 
Step 2 

Step 3 
Summarize FAF4.1 Freight Flows by NEMR TD&I Origin and 

Destination STAZ, Commodity Group and Freight Mode 

Step 4 Extract Truck Trip Freight Flows 

Step 5 
Divide Truck Freight Flows (by commodity group) by Average 

Truck Capacity (in tons) to calculate Truck Trips 

Convert Yearly Truck Trips (by commodity group) into Daily and 
Step 6 Hourly Flows 

Assign Truck Trips (by commodity group or in total) to NEMR 

TD&I Highway LinksStep 7 

CHAPTER 3: 

DOWNLOADING AND CONFIGURING THE NEMR TD&I MODEL 

& DATA 

HOW THE NEMR TD&I MODEL WORKS WITH TRANSCAD 

The NEMR TD&I Model is written in GISDK, a proprietary scripting language that works with 

TransCAD. Both GISDK and TransCAD are products of the Caliper Corporation. To use the NEMR 

TD&I Model, you must have purchased a legal copy of TransCAD. 

3.1 
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3.2 

The NEMR TD&I Model runs by accessing designated TransCAD procedures which generate 

new data files to be used sequentially in the standard 4-step travel demand forecasting model as 

follows: 

Input Files TransCAD Procedure Output File 

Population & Job Projections > Trip Generation > Trip Productions & Attractions 

Highway Network File Minimum Path Calculation > Minimum Path File 

Productions & Attractions 

& Minimum Paths > Trip Distribution Total Trip Table 

Total Trip Table 

& Mode Share Percentages >Mode Share Analysis Trip Table by Mode 

Highway or Transit Network File 

& Modal Trip Table > Traffic & Route Assignment Traffic Flows by Link 

Note that once created and saved, these data files can later be accessed by TransCAD outside of a 

NEMR TD&I session. 

To run the NEMR TD&I Model, it must first be compiled and linked to TransCAD.. 

DOWNLOADING AND CONFIGURING THE NEMR TD&I MODEL & DATA 

The NEMR TD&I Model and associated input data can be downloaded from the Download 

section of the Northeast Megaregion Travel Demand and Investment Model website ( ). The 

model scripts must be downloaded separately from the data. The model scripts are all contained in 

one .zip file (NEMRModelScripts.zip) while the data (NEMRModelData.zip) is contained in 

another. The following steps explain how to download the model scripts and data, create a robust 

file structure, and link the model scripts to TransCAD. 

1. Go to the NEMR TD&I website). Once there, go to the Download Center. 

2. Click on the Download Model Scripts link. Your browser will ask you for a destination 

location for the .zip file that contains the various model scripts. Create a “temp” folder on 

your desktop or local disk drive and download it there. 
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3. Create a new folder on your Desktop or local disk drive named “NEMRModel” and unzip the 

model scripts into it. 

4. Repeat Steps 2 and 3 for the Download Data link. 

5. Properly unzipping the model scripts and data to the “NEMRModel” folder should create a 

folder and directory structure that looks as follows: 

The BOS (Boston MAC), NYC (New York MAC), PHL (Philadelphia MAC), and WDC (Washington 

DC MAC) Region folders each contain all the relevant input files and data for their 

corresponding metro area clusters. The NEMR (Northeast Megaregion) folder contains similar 

files and data for the entire Northeast Megaregion. The Output folder is where files generated 

by the NEMR TD&I Model will automatically be stored. The Custom folder is where files used 

by the Projection Editor and Mode Share Editor modules will be copied to and modified 

Each Region folder contains the following files and folders: 
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The HBO, HBW, and NHB folders contain mode share information for all appropriate region 

modes (car, rail, bus, subway). 
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MapFiles contains road and rail geography files that users can import to TransCAD in order to 

generate Flow Maps using finished Traffic Assignment tables from the Model. 

31 



 

         

       

          

     

 

 
              

  

 
 

           

        

         

         

      

 
              

            

         

 

 
      

 
 

  
 

 

          

     

 
 

   

   

  

   

  

  

 
 

     
 

 

            
 

 

Network files (.net) for each region and mode are in this folder. The relevant MACZone 

geography file contains data that will be used by the Model to generate Trip Productions and 

Attractions. Finally, the Distance and Time Shortest Path files are default matrices used to create 

total trip matrices for each relevant purpose. 

6. Before the NEMR TD&I Model script can be run, it must be compiled within TransCAD. 

[More here] 

7. To run the NEMR TD&I Model….. Upon opening, the “Getting Started” tab in the NEMR 

TD&I Model will ask you to identify a particular file path from which it will draw needed 

data inputs. Set this path to either “NEMR,” “BOS”, “NYC”, “PHL”, or “WDC.”After 

compiling the NEMR TD&I Model, the user will be asked to identify the specific path location 

of this folder on the first tab. 

Upon downloading the Model script and compiling it in TransCAD, you should be able to follow 

the relevant instructions to correctly set your Input and Output file paths according to the location 

of your NEMRModel download. The Model should be able to run smoothly from there. 

3.3 DATA FILE ORGANIZATION AND STRUCTURE 

3.3.1 Directories 

As noted above, the input and output data files used by the NEMR TD&I Model are organized 

according to the following directory structure: 

Home Directory o Boston 

Input Files o NEMR Input 

Files o New 

York Input Files o 

Philadelphia Input Files o 

Washington Input Files o 

All Output Files 

3.3.2 Input File Types and Characteristics 

The NEMR TD&I Model includes four sets of input files per study area. These include: 
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1. Population and employment projections for 2030 and 2040, which are used in the Trip 

Generation step to generate future trip productions and attractions by TAZ and trip purpose. 

Separate input files are included for each of three projection methods (current state-based 

forecasts, current growth trends, and current share trends) and for each projection year (2030 

and 2040). These files are each stored in TransCAD’s table format. 

2. Highway and transit network files, which are used to construct minimum highway travel 

minimum paths between every TAZ origin and destination pair as input into the Trip 

Distribution step; as well as to provide the base layers for assigning and displaying 

highway and transit vehicle and passenger flows. These files are stored in TransCAD’s 

network file format. 

3. Default highway minimum path files, which list the highway links that comprise the 

minimum time path between each TAZ origin destination pair. These files serve as inputs 

into the Trip Distribution step. These files are meant to be used as the default option for 

users NOT wishing to generate new minimum path files. These files are stored in 

TransCAD’s network file format 

4. Mode share tables, which list the different highway, commuter rail, subway, and bus mode 

shares between every TAZ origin and destination pair. These estimates are derived from 

the 2017 national Household Transportation Survey (NHTS) or from local MPO surveys and 

are used to divide the total trip table created in the Trip Distribution step into its modal 

component trips. Separate mode share files are included for each trip purpose (HBW, HBO 

and NHB) and mode (highway, intercity rail, commuter rail, subway/lightrail, and bus). 

These files are each stored in TransCAD’s table format. 

In addition, users can access 2030 and 2040 truck trip tables for the Full Megaregion (FMR) 

Model created using freight flow data from the U.S. Department of Transportation ‘s Freight 

Analysis Framework (FAF version 4.1) Model. These files are also stored in TransCAD’s table 

format. 

Each set of input files is located in the Study Area home directory (e.g., the population and 

employment projections for the Boston-Providence-Worcester Metro Area Cluster (MAC) are 

located in the “/Boston Study Area” directory, while the highway, commuter rail, subway, and bus 

network files for the Greater Philadelphia Metro Area Cluster are located in the “/Philadelphia 

Study Area” directory. 
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3.3.3 Default Output File Locations 

Each step in the NEMR TD&I Model produces one or more output files (e.g., the Trip 

Generation step produces a file of 2030 or 2040 trip productions and attractions; while the Trip 

Distribution step produces a total trip table detailing the number of trips between each TAZ 

origin-destination pair.) These files are located always located in the “/Output” directory 

regardless of study area, and can be identified according to the name of the process used to create 

them: 

• TripGen_Output 

• MinPath_Output 

• TripDist_Output. 

• ModeShare_Output 

Each successive step in the NEMR TD&I Model is automatically set up to use the output from the 

previous step as its input. This means that prior output files are automatically overwritten every 

time the user undertakes a new NEMR TD&I Model run. For this reason, each step in the NEMR 

TD&I Model gives the user to copy its output to an external location. This allows users to 

accumulate intermediate output files for later analysis and use. Note that there is no default 

location for the results of the Traffic and Route Assignment step, and that users must save the 

results of that step to an external location. 

3.4 USER INPUT FILES AND TABLES 

3.5 SAVING USER OUTPUT FILES AND TABLES 

34 



 

       
 
 

             

            

         

          

           

 
 
 

       
 

            

        

          

           

          

       

 

 
     

 

     

    

   

   

     

            

   

        

        

           

               

               

              

           

          
 

          
 

 

CHAPTER 4: NEMR TD&I MODEL DATA INPUTS 

The NEMR TD&I Model uses four sets of inputs: (i) a set of population and job projections for 

2030 and/or 2040 as input into its trip generation procedures; (ii) a series of highway, rail, and bus 

networks as input into its trip distribution and traffic assignment procedures; (iii) mode share 

tables as input into its modal trip calculation procedures; and (iv) a table of truck trips as an option 

input into its traffic assignment procedures. Each of these inputs is explained in greater detail 

below. 

4.1 POPULATION AND JOB PROJECTION DATA INPUTS 

The NEMR TD&I model uses a series of 2030 and 2040 population and job projections as inputs 

into the Trip Generation step, which calculates trip productions and attractions from and to each 

transportation analysis zone. These projections were developed at the county level for the Full 

Megaregion (FMR) Model and at the zip code district level for the four MAC Models. The data 

are stored in TransCAD’s native database format, but can be edited using the Projections Editor 

script, which exports the data as an Excel (.xlsx) spreadsheet, and then re-imports any user 

changes. 

Key data fields in the Projections data files include: 

• Superzone TAZ number (STAZ) 

• MAC TAZ number (MTAZ) 

• State number 

• State abbreviation 

• County or place name 

• Population projection for 2030 or 2040 by STAZ or MTAZ • Job projection for 2030 or 

2040 by STAZ or MTAZ 

• Household projection for 2030 or 2040 by STAZ or MTAZ 

• Automobiles Available for 2030 or 2040 by STAZ or MTAZ 

• # of Households with 0 cars in 2030 or 2040 by STAZ or MTAZ 

• # of Households with 1 car in 2030 or 2040 by STAZ or MTAZ • # of Households with 2 

car in 2030 or 2040 by STAZ or MTAZ • # of Households with 3 car in 2030 or 2040 

by STAZ or MTAZ • # of Households with 4 car in 2030 or 2040 by STAZ or MTAZ 

• # of Households with 5 car in 2030 or 2040 by STAZ or MTAZ 

• # of Retail Jobs in 2030 or 2040 by STAZ or MTAZ 

• # of Service Jobs in 2030 or 2040 by STAZ or MTAZ 
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• # of Other Jobs in 2030 or 2040 by STAZ or MTAZ 

To help users analyze the travel impacts of alternative growth futures, three different sets of 

forecasts were created: 

4.1.1 Projection Set 1: County and Superzone-level 2030 and 2040 Population and Job 

Projections based on State-generated Population Forecasts: This set of projections 

makes use of the current “as-is” set of 2030 and 2040 county population forecasts 

developed by each NEMR state. Most states use some combination of trend and cohort 

survival methods to develop their population projections, and no attempt was made to 

standardize methods or models among states. 

Since states do not routinely develop long-term job projections, we started with the 

assumption that the 2015 job-to-population ratio in each county will remain unchanged 

through 2030 and 2040. This assumption, which presumes that the connection between the 

number of residents and the number of jobs in each county is fairly stable, enabled us to 

convert county-level population projections into county-level job projections. 

To account for expected increases in labor force participation rates, 2030 state-level 

population-to-jobs ratios are reduced by 0.1 compared to their 2015 values and reduced by 

another 0.1 for 2040. These upward-adjusted state employment projections are then used 

as control totals to adjust county-level 2030 and 2040 job projections. 

TransCAD’s trip generation routines also require information on the number of future 

households and retail jobs. These were generated from county-level population and job 

projections using 2015 household-to-population and retail job-to-total job ratios. 

As input into the MAC Models, county-level population and job projections are then 

converted to MTAZ-level population and job projections using 2015 MTAZ-to-county 

population and job ratios. 

4.1.2 Projection Set 2: County-level Growth Trend Projections: Most state population 

forecasts assume that county-level population growth trends will correspond to state-level 

trends. This second set of population and job projections relaxes this assumption by 

allowing recent county-level population and job growth trends to continue forward on 

their own through 2030 and 2040 so long as they do not collectively exceed state forecasts. 

In terms of developing population projections, we begin by calculating annualized rates of 

population growth or decline between 2000 and 2018 for each county. These 2000-2018 

annualized change rates are then applied forward for 12 and 22 years to yield 2030 and 

2040 county population estimates. These county-level estimates are then adjusted upward 
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or downward so that in total do not exceed or fall short of their respective state population 

projection. 

A similar procedure is used to generate 2030 and 2040 job projections. Using data from 

the 

U.S. Department of Commerce’s County Business Patterns series, we first calculate 

2012to-2018 annualized rates of employment change for each county. To prevent any past 

shortterm job bursts—either positive or negative—from cascading uncontrollably forward, 

we impose categorical limits of +1% and -1% on each county’s annualized job growth 

rate. 

These modified job growth rates are then applied forward for 12 and 22 years to generate 

2030 and 2040 job projections. The resulting county-level job projections are then 

aggregated to the state level where they are cross-checked to the state job totals produced 

in the previous method (which account for rising labor force participation rates) and 

modified upward or downward as need be. This prevents the sum or the parts (counties) 

from exceeding the whole (states). 

With these corrected 2030 and 2040 population and job projections in hand, we then apply 

the same 2015 county-level population-to-household and retail-job-to-total job ratios used 

in the previous forecasting method to project 2030 and 2040 county-level households and 

retail jobs. 

As input into the MAC Models, these county-level population, household and job 

projections are then converted to Superzone-level projections using 2015 Superzone-

tocounty population and job ratios. 

4.1.3 Projection Set 3: County-level Share Trend Projections: This third set of population and 

job projections assumes that recent share trends relating each county’s population and job 

totals to its respective state will continue through 2030 and 2040. For example, if a 

county’s share of its state’s population fell from 12% in 2000 to 10% in 2018 and this 

trend continues, then its 2030 population share will be 8.67% (10% - [12 years * -.11% 

annual share change]), and its 2040 population share will be 7.56% (10% - [22 years * -

.11% annual share change]). After being adjusted upward or downward to ensure that the 

statewide share total doesn’t exceed 100%, these county share projections are then 

multiplied by their respective state’s 2030 and 2040 statewide population projections to 

yield county-level population and job projections. 

As with the previous two projection sets, these population and job projections are then 

converted into households and retail jobs using 2015 county-level population-to-household 
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and retail-to-total jobs ratios. As input into the MAC Models, these county-level population, 

household and job projections are then converted to Superzone-level projections using 2015 

Superzone-to-county population and job ratios. 

► Users wishing to input their own projections as the basis for a NEMR TD&I Model run 

should use the Projections Editor script to do so. The Projections Editor script exports one 

or more projections from its native TransCAD file format to an Excel file, where existing 

values can be edited or new values inserted. Once any changes are made, the Projections 

Editor will convert the file to a TransCad-compatible file format and correctly join it to 

appropriate source file. 

For illustrative purposes, Exhibit 4A presents a side-by-side comparison of the three population 

and job projection results for Connecticut’s six counties. 
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Exhibit 4A: Comparison of Connecticut County 2030 and 2040 Population and Job Forecasts 

New New 

County ► Fairfield Hartford Litchfield Middlesex Haven London Tolland Windham 

Superzone TAZ 

101 102 103 104 105 106 107 108 

Number 

Population 2015 994,943 896,290 186,304 165,165 860,186 273,185 151,948 117,470 

Jobs 2015 421,295 440,169 51,957 60,899 335,845 102,909 32,903 30,354 

State-generated Population Forecasts 

Pop 2030F 897,553 930,629 180,866 166,533 891,371 280,847 155,697 130,497 

Pop 2040F 905,219 948,876 170,300 163,400 900,635 276,200 154,600 134,900 

Jobs 2030F 409,726 492,712 54,378 66,197 375,189 114,054 36,347 36,353 

Jobs 2040F 429,849 th 522,582 53,261 67,564 394,339 116,679 37,543 39,091 

Trend P rojections 
County-level Grow 

Pop 2030F 510,734 2,202,824 92,647 86,570 455,377 139,311 83,261 63,270 

Pop 2040F 202,413 3,092,212 35,168 33,881 177,782 53,868 33,575 25,103 

Jobs 2030F 447,093 497,494 51,087 66,013 358,034 106,211 27,078 31,946 

Jobs 2040F 470,003 529,418 50,513 69,370 375,485 106,505 26,616 32,998 

County-level Share T 

Pop 2030F 975,309 905,019 176,634 165,356 866,043 266,014 158,804 120,815 

Pop 2040F 991,839 906,882 171,622 166,115 866,595 263,913 164,041 122,992 

Jobs 2030F 448,874 499,307 51,121 66,277 359,471 106,445 21,390 32,071 



 

 

 

                 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Jobs 2040F 473,622 532,987 50,403 69,905 378,408 106,768 15,572 33,245 
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4.2 HIGHWAY AND TRANSIT NETWORKS 

Like all 4-step travel demand models, the NEMR TD&I Model makes extensive use of highway and 

transit networks to derive minimum time and distance routes between every trip origin and 

destination zone and for traffic assignment purposes. Minimum paths are used as inputs into Trip 

Distribution procedures as well as to generate trip level-of-service characteristics as inputs when 

building mode share models. 

Networks consist of links, nodes and centroids. Links are road or transit route segments and begin 

and end at nodes. Nodes are connection points for one or more links. Centroids are specialized nodes 

located at the centers of TAZs. Travelers embark and disembark from trips at centroids, travel along 

links, and transfer at nodes. In addition to locational and connection characteristics, links, nodes and 

centroids all have attributes. Link attributes include length, travel speed, travel time, and typically 

vehicle capacity. Node attributes include turning movements and turning capacity. 

The NEMR TD&I Model makes use of three types of networks: 

4.2.1 The National Highway Network as implemented in TransCad which includes interstate 

highways, limited access roads, and major and minor arterials. It does not include collector 

roads and non-through streets. TransCAD’s version of the National Highway 

Network comes “pre-built,” meaning that its links and nodes are already connected and that 

vehicles can flow through it. 

4.2.2 Urban rail and bus networks as implemented using the open-source General Transit Feed 

Specification (GTFS) format. GTFS data is available online for most U.S. commuter rail, 

subway, light-rail, and urban bus systems. GTFS data consists of multiple 

data files that are linked “relationally” through a common field. Exhibit 4B summarizes the 

standard GTFS data files and structure. Once downloaded, GTFS-based transit networks 

must be “built,” meaning their links and nodes must all be properly connected. 

4.2.3 Amtrak and inter-city rail links as assembled from multiple GTFS files and the National Rail 

network. 

All told, the NEMR TD&I model includes two megaregion-scale networks and 14 sub-regional 

networks, four for each MAC area: 

1. A single highway network that covers the full Northeast Megaregion. 
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2. A single inter-city rail network that covers the full Northeast Megaregion composed of Amtrak 

lines. 

3. A highway network that covers the Boston-Providence-Worcester MAC area. 

4. A GTFS-based regional and commuter rail network that covers the Boston-

ProvidenceWorcester MAC area. 

5. A GTFS-based subway and light-rail network that covers the Boston-ProvidenceWorcester 

MAC area. 

6. A GTFS-based urban bus network that covers the Boston-Providence-Worcester MAC area. 

7. A highway network that covers the Greater New York City MAC area. 

8. A GTFS-based regional and commuter rail network that covers the Greater New York City 

MAC area. 

9. A GTFS-based subway and light-rail network that covers the Greater New York City MAC 

area. 

10. A GTFS-based urban bus network that covers the Greater New York City MAC area. 

11. A highway network that covers the Greater Philadelphia MAC area. 

12. A GTFS-based regional and commuter rail network that covers the Greater Philadelphia MAC 

area. 

13. A GTFS-based subway and light-rail network that covers the Greater Philadelphia MAC area. 

14. A GTFS-based urban bus network that covers the Greater Philadelphia MAC area. 

15. A highway network that covers the Baltimore-Washington, DC-Richmond MAC area. 

16. A GTFS-based regional commuter rail network that covers the Baltimore-Washington, 

DCRichmond MAC area. 

17. A GTFS-based subway and light-rail network that covers the Baltimore-Washington, 

DCRichmond MAC area. 

18. A GTFS-based urban bus network that covers the Baltimore-Washington, DC-Richmond 

MAC area. 

Exhibit 4B: General Transit Feed Specification [GTFS] File 

Structure 

GTFS File Fields 
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[Transit] 
Agency 

Name 

URL 
Timezone 

Route 

Route ID 

Route Name (short) 

Route Name (long) 

Route Type 

[Vehicle] 

Trip 

Trip ID 

Route ID {links to Routes file} 

Service ID 

Schedule Block (optional) 

Stop Times 

Stop ID {links to Stops File} 

Trip ID {links to Trips file} 

Arrival time 

Departure time 

Stop sequence 

Stop 

Stop ID {Links to Stop Times file} 

Stop Name 

Stop Longitude 

Stop Lattitude 

Calender 

File 

Service ID {links to Trips file} 

Service day 

Start date 

End date 

Optional 

.txt Files 

Calendar dates 

Fare attributes 

Fare rules 

Shapes 

Frequencies 

Transfers 

Feed Information 

Note: Color-coding indicates key fields in multiple GTFS 

44 



 
 

               

        

           

              

             

   

 
             

            

            

  
 

 

            

       

         

        

 

 
 
 

            

                

                 

                

 
 
 
 

     
 

 

             

         

           

          

 
            

          

        

       

         

The NEMR TD&I model does not include a bus network or commuter rail network that covers the 

full megaregion. The various highway networks connect to every Superzone TAZ and MAC TAZ at 

their respective centroids. The transit networks connect only to those Superzone and MAC TAZs that 

they provide a particular transit service to. As a practical matter, this means that while it is possible 

to travel by car to and from every TAZ, the range of TAZs served by bus and particularly rail modes 

is much more limited. 

Travelers can access the rail or bus networks either by walking or driving. They cannot access the 

highway network via a transit mode. Transit passengers are allowed an unlimited number of transfers 

within transit modes (e.g., from one bus route to another) but only one transfer between transit 

modes (e.g., bus-to-commuter rail). 

None of the highway networks include link or node vehicle capacity measures. This means that the 

NEMR TD&I Model cannot perform traffic assignments that make use of volume-to-capacity 

measures to reallocate vehicle traffic away from congested links. The various transit network do 

include headway and schedule data, but they are not used in the NEMR TD&I’s transit route 

allocation runs. 

Since all the NEMR TD&I Model networks come “pre-built,” they cannot be easily edited by users 

while in a NEMR TD&I Model session. Users interested in adapting any of the NEMR TD&I 

networks (e.g., to add new links or nodes or change link and node attributes) for their own use 

are free to do so and should consult TransCAD’s “Help” feature for tips about editing and 

modifying networks. 

4.3 MODE SHARE PERCENTAGE TABLES 

The NEMR TD&I Model uses a series of mode share percentages to divide the “combinedmodes” 

trip table produced in the Trip Distribution step into multiple trip tables that list trips between every 

origin-destination pair by mode (e.g., highway, rail, subway, and bus trips). These are the trip 

volumes that are then allocated to roads and transit lines in the Route Assignment step. 

For the Full Megaregion (FMR) Model, the mode share percentages are derived from the 2017 

National Household Travel Survey (NHTS). For the MAC Models, the mode share percentages are 

based on the results of travel demand and behavior surveys conducted by individual metropolitan 

planning organizations (MPOs). Because each survey is organized differently, the different mode 

share tables each follow slightly different formats. This section reviews those formats. 
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4.3.1 Full Megaregion Model Mode Share Table: The Full Megaregion Model (FMR) makes use 

of metro area-specific trip activity data published in the 2017 National Housing Travel 

Survey (NHTS) for the Baltimore, Boston, Hartford, New York City, 

Philadelphia, Providence, Richmond, and Washington, D.C. metropolitan areas. The 2017 

NHTS data has very good coverage in terms of mode, trip distance and trip time, but is less 

detailed with regard to trip purpose and destination. Outside of the New York 

City metropolitan area, the 2017 NHTS’s sample sizes for some modes can be on the small 

side. With these limitations in mind, the modal share table for the FMR is organized by metro 

area, trip purpose, and trip distance category as shown in Exhibit 4B; with the top four mode 

shares listed for each combination of trip purpose and trip distance. Trips originating in 

counties that fall outside a listed metropolitan area are assigned mode share percentages 

based on the average of all trips originating within the NEMR. These percentages are used to 

build individual mode share tables for every Superzonal pair based on trip purpose, county of 

origin and trip distance category. 

4.3.2 Boston Regional MAC Mode Share Table: Unlike the New York, Philadelphia, and 

Washington DC MAC Models, the Boston MAC Model draws on Boston area trip activity 

data published in the 2017 National Housing Travel Survey rather than the results of a local 

MPO survey. The resulting mode share tabulations list the mode share percentages for the top 

four modes (e.g. car, commuter rail, bus, taxi, subway, bike/walk, or air) for each 

combination of trip purpose (home-based work, home-based other, nonhome-based), and trip 

distance category (less than one mile, 1-3 miles, 3-5 miles, 5-10 

miles, 10-15 miles, 15-20 miles, 20-30 miles, 30-40 miles, 40-50 miles, 50-75 miles, 75100 

miles, and 100+ miles). 

4.3.3 New York Regional MAC Model Mode Share Table: The New York City Area MAC Model 

draws on mode share percentages calculated from the New York Metropolitan 

Transportation Council’s 2010/2011 Regional Household Travel Survey. The resulting mode 

share tabulations list the mode share percentages for the top four modes (e.g. car, commuter 

rail, bus, taxi, subway, bike/walk, ferry, or air) for every combination of origin county (e.g., 

Bergen, Bronx, Brooklyn, Duchess, etc.), trip purpose (home-based work, home-based other, 

non-home-based), and trip distance category (less than one mile, 1-3 miles, 3-5 miles, 5-10 

miles, 10-15 miles, 15-20 miles, 20-30 miles, 30-40 miles, 40-50 miles, 50-75 miles, 75-100 

miles, and 100+ miles). These percentages are used-build individual mode share tables for 

every New York City area zonal pair based on purpose, county of origin and trip distance 

category. 
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4.3.4 Philadelphia Regional MAC Model Mode Share Table: The Philadelphia Area MAC Model 

draws on mode share percentages calculated from tabulations of the Delaware 

Valley Regional Planning Commission’s 2012 Household Travel Survey. These mode share 

tabulations list the mode share percentages for the top four modes (e.g. car, commuter rail, 

bus, taxi, subway, bike/walk or air) for every combination of origin county (e.g., Bucks, 

Camden, Chester, etc..), trip purpose (home-based work, home-based other, non-home-

based), and trip distance category (less than one mile, 1-3 miles, 3-5 miles, 5-10 miles, 10-15 

miles, 15-20 miles, 20-30 miles, 30-40 miles, 40-50 miles, 50-75 miles, 75-100 miles, and 

100+ miles). These percentages are then used-build individual mode share tables for every 

Philadelphia area zonal pair based on purpose, county of origin and trip distance category. 

4.3.5 Baltimore - Washington DC Regional MAC Model Mode Share Table: The Baltimore-

Washington DC-Richmond MAC Model draws on mode share percentages calculated from 

the Baltimore Metropolitan Council’s 2001 Household Travel Survey and the National 

Capital Region Transportation Planning Board’s 2007-2008 TPB Household Travel Survey. 

The resulting mode share tabulations list the mode share percentages for the top four modes 

(e.g. car, commuter rail, bus, taxi, subway, bike/walk or air) for every combination of origin 

county (e.g., Anne Arundel, Baltimore City, Baltimore County, etc..), trip purpose (home-

based work, home-based other, non-homebased), and trip distance category (less than one 

mile, 1-3 miles, 3-5 miles, 5-10 miles, 10-15 miles, 15-20 miles, 20-30 miles, 30-40 miles, 

40-50 miles, 50-75 miles, 75-100 

miles, and 100+ miles). These percentages are then used-build individual mode share tables 

for every The Baltimore-Washington DC-Richmond zonal pair based on purpose, county of 

origin and trip distance category. 

► The NEMR TD&I Model’s Mode Share procedures allow users to categorically increase or 

decrease particular mode share percentages (e.g., increase the share of home-based 

work trips in the Boston area using commuter rail by 10%) for the NEMR or MAC 

modeling regions. It does not permit users to adjust mode share percentages for 

particular origin-destination pairs or trip distance categories. 
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CHAPTER 5: 

FULL MEGAREGION (FMR) MODEL TUTORIAL 

This chapter works through the steps involved in running the NEMR TD&I Model for the entire 

Northeast Megaregion (NEMR) Study Area. As a reminder, the Full Megaregion (FMR) model 

makes use of county-based 2030 and 2040 population projections and is limited to simulating 

highway and inter-metropolitan rail trips. 

The NEMR TD&I Model works by stepping through a sequence of six menu tabs that correspond to 

the steps in the standard 4-Step travel demand model. These menu tabs were 

created using GISDK, TransCAD’s scripting language, and work by making calls to standard 

TransCAD procedures. Running the NEMR TD&I Model therefore requires having a legal copy 

of TransCAD installed and open on the user’s own desktop or laptop computer. To make the most of 

the NEMR TD&I Model, prospective users should endeavor to develop a working knowledge of 

TransCAD procedures, data formats, and display tools. 

The six FMR and MAC Model menu tabs include: 

• A GETTING STARTED menu tab which ask the user to set a Study Area and Forecast Year. 

• A TRIP GENERATION menu tab which lets users specify which population and employment 

projections they wish to convert to Trip Productions and Attractions. 

• A CREATE MINIMUM PATHS menu tab which uses the appropriate highway network to 

generate a series of minimum travel time paths between every origin and destination TAZ in the 

selected study area. 

• A TRIP DISTRIBUTION menu tab which uses the minimum time paths created in the previous 

step as input into a gravity model which converts the production and attractions created in the 

Trip Generation step into a Total Trip Table of trip-making activity for every origin-destination 

zonal pair in the selected study area. 

• A MODE SHARE ANALYSIS menu tab which uses survey data results or user-specified mode 

shares to divide the total trip table generated in the Trip Distribution step above into 
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one or more Modal Trip Tables (e.g., the number of trips between each origin and destination 

zone by highway, commuter rail, subway, bus, etc.). 

• A ROUTE ASSIGNMENT menu tab which assigns the modal trip flows generated in the Mode 

Share step to particular highway, rail, or bus routes using different route assignment criteria (e.g. 

all-or-nothing, capacity constrained, etc.). When used at the Full Megaregion scale, the NEMR 

TD&I Model can also be used to assign truck trips to highway links. 

The results of the Route Assignment procedure include route volume flow files which can be 

summarized, displayed and compared using TransCAD’s map-based user interface or else imported 

into route tables and compared with other route assignment results. 

Except for the GETTING STARTED menu tab, each menu tab produces a new TransCAD data file 

which then serves as input into the next menu tab procedure. As an option, these intermediate data 

files can also be save to user-specified locations where they can be used by TransCAD independently 

of the NEMR TD&I Model. 

The following step-by-step tutorial will: (1) Build a set of 2040 trip productions and attractions by 

county for the Full Megaregion (FMR); (2) Build a set of highway shortest time paths between every 

county-based trip origin and destination zone (O-D zonal pair) in the FMR; (3) Use the minimum 

paths as input into a gravity model which will convert the county-based productions and attractions 

into a complete trip table of home-based work trips; (4) Identify the share of trips between each O -D 

zonal pair that will travel by highway; (5) Allocate those highway trips to the appropriate shortest 

route on an all-or-nothing basis, and (6) Graph those trips on the appropriate highway network 

routes. 

1. Make sure TransCAD is properly installed on your computer and then open it. 

2. Access the NEMR TD&I Model script by opening TransCad and clicking on Tools > GIS 

Developer’s Kit. After the “GISDK Toolbar” appears on your menu TransCad menu bar, click 

on the “Compile to UI” icon. Then, navigate to the NEMR TD&I Model script (wherever you 

have downloaded and saved it) and follow the directions to compile the script. 

3. After the NEMR TD&I Model script has been compiled, click on Tools > GIS Developer’s 

Kit > Add-Ins. Select the “NEMR TD&I Model” script to open the NEMR TD&I Model’s tab-

based interface. 
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4. If you have not previously done so previously, use File Explorer to navigate to the locations 

where you have downloaded the various model datafiles to make sure they are all there. 

1. Getting Started 

5. Click on the GETTING STARTED menu tab to choose a study area and forecast year for this 

model run. 

► Confirm that your Input Path setting is pointing to the appropriate NEMR destination 

directory where you downloaded the NEMR TD&I Model. ◄ 

► Confirm that your Output Path setting is pointing to the “Output” Directory. ◄ 

► Confirm that your External Path setting is pointing to a directory where you can write output 

files. ◄ 

► In the Choose a Study Region box, choose “NEMR” to indicate you will be using the Full 

Northeast Megaregion (FMR) model option.◄ 

► In the Choose a Forecast Year box, choose “2030” to indicate you will be developing trip 

projections for the Year 2030.◄ 
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2. 
Trip Generation 

6. Next, click on the TRIP GENERATION menu tab to choose which population and 

employment projections you will be using and which trip purpose type you will be generating 

trips for. 

► For the purposes of this example, choose the “State Projections” option, which indicates you 

will be using population projections created by the individual states in the NEMR ◄ Chapter 4 

in this manual explains the differences between the three forecast options. 

☼ If instead of the one of the three default projection methods, you wish to use your own, 

choose the “User Projections” option. Then, click on the Get User Projection File command 

bar to retrieve your own set or population and job projections. 

7. Click on the Generate and Balance Trip Productions and Attractions command bar. This 

will tell TransCAD to use the NCHRP 365 Trip Generation method to convert your countylevel 
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population and employment forecasts into home-based work trip productions and attractions. It 

will also ensure that the number of productions exactly equals the number of attractions. 

8. (Optional): The NEMR TD&I Model will automatically save the results of the Trip Generation 

step to the Trip Generation Productions and Attractions Output file. If you also want to copy 

the results to a location where they can be independently accessed, click on the Copy P&A 

File to External Location command bar, and then follow the appropriate prompts to name and 

save your file. 
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3. 
Trip Distribution Steps 

9. Click on the GENERATE MINIMUM PATH menu tab. This set of procedures will create a set 

of minimum path “skim trees” consisting of the minimum time or distance path between every 

origin and destination zone in your study area. As currently implemented, all NEMR TD&I 

Model minimum paths are based on highway travel times and/or distances. For this example, 

we will allow two-way travel on all highway links, not impose any turn penalties, and keep 

track of the minimum time path in minutes. In the Minimum Path Parameters box: 

► Choose “Yes” to the Ignore Link Direction option◄ 

► Choose “Yes” to the Keep Duplicate Links option ◄ 

► Choose “Yes” to Turn Penalties ◄ 

► Choose “Minutes” as your Time Unit ◄ 
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► Choose “Shortest Time” as your Minimum Path Metric ◄ 

10. In the Select Highway Network for Analysis box, choose “Study Area Highway Network” to 

indicate that you will be using the Full Megaregion study area highway network to build the 

minimum path skim trees. 

☼ Alternately, if you would prefer to use an alternative highway network to construct your 

minimum paths, choose the “User Highway Network Option”, and then click on the Get 

User Highway Network Files to indicate the appropriate file path where your network can be 

found. Note that any user-specified networks must reference the same traffic analysis zone 

(TAZ) numbers as the default Boston study area highway network.. 

11. (Optional): If you want to copy the soon-to-be-generated set of minimum paths to an external 

file location, click on the Copy Minimum Path File to External Location command bar, and 

then follow the appropriate prompts to name and save your file. Make a note of the location of 

your exported file. 

12. Review your selections to make sure they are correct, and then click on the Generate 

Minimum Paths command bar to generate a full set of highway minimum paths. Note that this 

process may take some time to complete. 

13. You should now be ready to run the Trip Distribution procedure. This procedure uses a gravity 

model to connect trip productions and trip attractions to form a set of complete trips for every 

origin and destination pair in your study area. 

14. Click on the TRIP DISTRIBUTION menu tab. 

15. In the Choose Trip Purpose box, choose which trip purpose you will use the gravity model to 

create a trip table for. ► In the current case, choose “HBW” to indicate you will be creating a 

trip table of Home-based Work trips. ◄ 

16. The Confirm Input File Locations box allows you to choose which trip productions and 

attractions and which minimum path skim trees you will use as input into the gravity model. 

► Choose “Use Default Study Area File Locations” to indicate you will be using the Full 

Megaregion study area productions and attractions file and minimum path files developed in 

the previous steps ◄. 
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☼ If instead of the default Full Megaregion productions and attractions and minimum path 

files generated in the previous steps, you wish to use your own, choose “User P&A File” 

and/or the “User-generated Minimum Path Files.” Then, depending on which options you 

chose, click on the Get User Production & Attractions File command bar and/or the Get 

User-generated Minimum Path command bar. Note that the Trip Distribution process will 

only work properly if your user-generated files have the same zone and variable structure as 

the default Boston area files. 

17. Review all your selections to make sure they are correct, and then click on the Create 

Total Trip Table command bar to run TransCAD’s Trip Distribution procedure. Note that this 

process may take some time to complete. 

18. (Optional): If you want to copy your trip table to an external location, click on the Copy Total 

Trip Table to External Location command bar, and then follow the appropriate prompts to 

name your file. Make a note of the location of your exported file. 
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4. Mode Share Calculations 

19. Click on the MODE SHARE menu tab. This set of procedures will all allow you to apply a 

series of mode share percentages to the total trip table created in the previous Trip Distribution 

step to generate a series of mode-specific trip tables. Depending on the study area, these mode 

share percentages are derived either from the 2017 National Household Travel Demand Survey 

or from travel surveys administered by local metropolitan planning organizations (MPOs). 

20. In the Choose Mode to Generate Trip Table box, click on the mode you wish to develop the 

trip table for. ► In the current case, choose “Highway or Car” ◄ Note that you can only 

develop one mode-specific trip table at a time. 

☼ The NEMR TD&I Model also gives users the option to import their own mode share tables 

or to modify an existing mode share table by increasing all the mode share percentages by a 

fixed amount. To import your own mode share table, click on the Import User Mode Share 

Table command bar and locate the table you wish to import. Then go to Step 22. 

21. In this example, we will be uniformly decreasing the share of commuter rail trips by 10% 

below their default values. Note that you can also choose to increase your trip shares. 
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► In the Modify Default Mode Share Table box, choose “Decrease Mode Shares” ◄ 

► Then, choose the percentage you wish to increase the current mode share percentage by. In 

the current example, choose “10%”◄. 

This will have the effect of decreasing the current highway rail mode share by 10% for all 

origin destination pairs. So, for example, if the current commuter highway mode share between 

an origin-destination pair is 80%, decreasing it by 10% will reduce the highway mode share to 

72% (80% - (80% * 10%)). Note that this will not affect the mode share of any other mode. 

22. Review all your selections to make sure they are correct, and then click on the Calculate 

Modal Trips command bar to calculate a trip table for your mode of choice. This is the trip 

table you will allocate to a route in the next step. 

23. (Optional): If you want to copy your just-created modal trip table to an external location (for 

later use, or so that you can generate a mode trip table for a different mode or purpose), click 

on the Copy Modal Trip Table to External Location command bar, and then follow the 

appropriate prompts to name your file. Make a note of the location of your exported file. 

5. Trip and Route Assignment 
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24. Click on the TRAFFIC & ROUTE ASSIGNMENT menu tab. This set of procedures will allow 

you to allocate the highway, rail, and bus trips generated by the MODE SHARE 

CALCULATOR to particular highway, rail, and bus links routes. The current version of the 

NEMR TD&I Model is limited to an “all-or-nothing assignment,” meaning that all trips are 

assigned to the shortest route regardless of congestion levels or available capacity. 

Users wanting to use a different route assignment method should do so in TransCAD. 

Unless otherwise indicated, all trip assignments cover a 24-hour period. Note that the Full 

Megaregion (FMR) model is limited to allocating highway and inter-city rail trips, and cannot 

be used to allocate commuter rail, subway, or bus trips. 

25. In the Confirm Modal Trips to Assign to Routes box, you can choose either the Default 

Option to indicate you will be using the modal trip table calculated in the previous Mode Share 

step, or the Import User Modal Trip Table to indicate you will be using a different modal trip 

table. ► In the current case, choose “Default” to indicate you will be using modal trip table 

created in Step 23. ◄ 

☼ If instead of the Default Option you had chosen to import a modal trip table of your own, 

you would now click on the Import User Modal Trip Table command bar. 
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26. When used at the Full Megaregion (FMR) scale, the NEMR TD&I model gives users the 

option of also assigning truck trips to highway routes, thereby providing a link-by-link estimate 

of traffic volumes that includes both car and truck trips. Truck trip volumes are generated using 

an updated version of the Federal Highway Administration’s Freight Management Framework 

(FMF4.1) freight flow model. ► In the current case, choose 

“Yes” to indicate you will be adding truck trips to the highway assignment ◄ Then, click on 

the Import Truck Trip Table to locate and access the appropriate truck trip table. 

27. Click on the Allocate Trips to Routes command bar. TransCAD will then begin the route 

allocation process, which, depending on the size of your study area and highway or networks, 

may take several minutes. Currently, the only available assignment method is 

“all or nothing,” meaning that all trips are allocated to the shortest highway path or transit 

route(s) regardless of congestion levels or available capacity. 

28. The NEMR TD&I Model gives users the option of preparing and saving multiple route 

allocations and saving the results in a location of the user’s choice. Accordingly click on the 

Copy Route Assignment Results to External Location command bar and choose the file 

location where you wish to save your route assignment results. Make a note of this location. 

29. You have now completed a run of the NEMR TD&I Full Megaregion Model. 

CONGRATULATIONS! 

6. Displaying Your Route Assignment Results in TransCAD 

30. Minimize the GISDK window in which you are running the NEMR TD&I Model. If you have 

not done so previously, start TransCAD and wait for it to load. If TransCAD is already 

open, use the Windows Task Bar to access it: 

31. Click on the TransCAD File Menu: 

► Open the Streets Map file in TransCAD and locate the NEMR study region. ◄ 

► Open the Traffic Assignment table you saved in Step 28 above. ◄ 

32. Click on the TransCAD View Menu and make the Streets Map file your primary TransCAD 

window. 
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33. Click on the TransCAD Planning Menu and choose Assignment Utilities > Create Flow 

Map: 

► For the Line Layer, select the Street Map file opened in Step 31, above ◄ 

► For the Flow Table, select the Traffic Assignment table opened in Step 31, above◄ 

► For the Flow Field, select the appropriate the Total Flow field (from Traffic 

Assignment table), most likely Tot_Flow◄ 

► For the V/C Field, select None (optional if V/C Field has been calculated by user) ◄ 

34. Click on OK to display your Route Assignment Flow Map. It will look something like the map 

below. The line colors and labels can be edited using the Display Manager and Map toolbars 

provided within the TransCAD user interface. Additional line layers can also be added to this 

flow map using the TransCAD interface. Upon clicking within the Flow Map window in 

TransCAD, the Display Manager will be visible on the right-hand side of the screen. This 

window shows all different line layers that are currently included in your Flow Map and allows 

you to manage what labels/icons will be displayed. For example, the Major Road icons can be 

toggled on or off by clicking on the green icons next to relevant road Features. 
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35. TransCAD also enables users to add additionallinework layers to give their Flow Maps more 

context. This can be done by going to the program toolbar and selecting Map >Layers. In the 
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Layers menu, you can choose to Add, Drop, or Hide different linework layers in your map. 

You can also use the Move Up/Down commands to arrange the linework layer display 

priorities within the Flow Map. 

36. The Layers dialogue box also offers additional user control over line color, line weight, and fill 

color/transparency. The options available are dependent on the shapes contained within each 

Layer being used in the map. The Display options can be accessed by double clicking on the 

relevant layer being edited within the Layer menu. Once the changes are made, click Apply to 

add them to the Flow Map. 

37. By taking some time to work with the Map Editing features, you can arrive at a Flow Map that 

displays your model results for presentation. 
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CHAPTER 6: 

BOSTON MAC MODEL TUTORIAL 

This chapter works through the steps involved in running the NEMR TD&I Model for the Boston-

Providence-Worcester Metro Area Cluster or MAC. As a reminder, the MAC models make use of 

transportation analysis zones (TAZs) that are assembled from zip code districts rather than counties, 

as is the case for the Full Megaregion (FMR)Model. Other significant differences between the FMR 

and MAC models is that the former are limited to highway and inter-city rail trips while the latter 

can also accommodate commuter rail, subway and light rail, and bus trips. The FMR Model is also 

capable of adding in truck trips while the MAC models are not. 

Note that the New York City, Philadelphia, and Washington DC-Baltimore-Richmond MAC Models 

all function in the same way as the Boston MAC Model. 

Like the FNEM Model, the MAC models work by stepping through a sequence of six menu tabs that 

correspond to the steps in the standard 4-Step travel demand model. These menu tabs were created 

using GISDK, TransCAD’s scripting language, and work by making calls to standard TransCAD 

procedures. Running any of the MAC Models therefore requires having a legal copy 

of TransCAD installed and open on the user’s own desktop or laptop computer. To make the most of 

the NEMR TD&I Model, prospective users should endeavor to develop a working knowledge of 

TransCAD procedures, data formats, and display tools. 

The six FMR and MAC Model menu tabs include: 

• A GETTING STARTED menu tab which ask the user to set a Study Area and Forecast Year. 

• A TRIP GENERATION menu tab which lets users specify which population and employment 

projections they wish to convert to Trip Productions and Attractions. 

• A CREATE MINIMUM PATHS menu tab which uses the appropriate highway network to 

generate a series of minimum travel time paths between every origin and destination TAZ in the 

selected study area. 

• A TRIP DISTRIBUTION menu tab which uses the minimum time paths created in the previous 

step as input into a gravity model which converts the production and attractions created in the 
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Trip Generation step into a Total Trip Table of trip-making activity for every origin-destination 

zonal pair in the selected study area. 

• A MODE SHARE ANALYSIS menu tab which uses survey data results or user-specified mode 

shares to divide the total trip table generated in the Trip Distribution step above into one or more 

Modal Trip Tables (e.g., the number of trips between each origin and destination zone by 

highway, commuter rail, subway, bus, etc.). 

• A ROUTE ASSIGNMENT menu tab which assigns the modal trip flows generated in the Mode 

Share step to particular highway, rail, or bus routes using different route assignment criteria (e.g. 

all-or-nothing, capacity constrained, etc.) 

The results of the Route Assignment procedure include route volume flow files which can be 

summarized, displayed and compared using TransCAD’s map-based user interface or else imported 

into route tables and compared with other route assignment results. 

Except for the GETTING STARTED menu tab, each menu tab produces a new TransCAD data file 

which serves as the input into the next menu tab procedure. Each of these newly-generated files is 

saved to a preset file location based on the chosen study area and forecast year (e.g. 

“/Boston2030/”. In addition, users can choose to export their results to directories of their own 

choosing (e.g., “/My Model Run/”) by clicking on the Copy Results to External Location, where 

they can be accessed by TransCAD independently of a particular NEMR TD&I Model run. 

The following step-by-step tutorial will: (1) Build a set of Year 2040 trip productions and 

attractions by county for the entire Boston-Providence-Worcester MAC Study Area; (2) Build a 

set of highway minimum time paths between every origin and destination traffic analysis zone (O-D 

zonal pair) in the Boston-Providence-Worcester MAC Study Area; (3) Use the generated minimum 

paths as input into a gravity model which will convert the county-based productions and attractions 

into a complete trip table of home-based work trips; (4) Identify the share of home-based work 

trips between each O -D zonal pair that will travel by commuter rail; (5) Allocate those commuter 

rail trips to the appropriate commuter rail routes;, and (6) Graph those trips on the appropriate 

commuter rail routes. 

1. Make sure TransCAD is properly installed on your computer and then open it. 

2. Access the NEMR TD&I Model script by opening TransCad and clicking on Tools > GIS 

Developer’s Kit. After the “GISDK Toolbar” appears on your menu TransCad menu bar, click 

on the “Compile to UI” icon. Then, navigate to the NEMR TD&I Model script (wherever you 

have downloaded and saved it) and follow the directions to compile the script. 
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3. After the NEMR TD&I Model script has been compiled, click on Tools > GIS Developer’s 

Kit > Add-Ins. Select the “NEMR TD&I Model” script to open the NEMR TD&I Model’s tab-

based interface. 

4. If you have not previously done so previously, use File Explorer to navigate to the locations 

where you have downloaded the various model datafiles to make sure they are all there. 
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1. Getting Started 

5. Click on the GETTING STARTED menu tab to choose a study area and forecast year for this 

model run. 

► Confirm that your Input Path setting is pointing to the appropriate NEMR directory location 

where you downloaded the NEMR TD&I Model. ◄ 

► Confirm that your Output Path setting is pointing to the “Output” Directory. ◄ 

► Confirm that your External Path setting is pointing to a directory where you can write 

output files ◄ 

► In the Study Area box, choose “Boston” to indicate you will be using the Boston-

Providence-Worcester MAC model◄ 

► In the Forecast Year box, choose “2040” to indicate you will be developing trip projections 

for the Year 2040.◄ 

2. Trip Generation Steps 
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6. Next, click on the TRIP GENERATION menu tab to choose which population and 

employment projections you will be using and which trip purpose type you will be generating 

trips for. 

► For the purposes of this example, choose the “Current Growth Trends” option◄ Chapter 

4 in this manual explains the differences between the three forecast options. 

☼ If instead of the one of the three default projection methods, you wish to use your own, 

choose the “User Projections” option. Then, click on the Get User Projection File command 

bar to retrieve your own set or population and job projections. Click on the Generate and 

Balance Trip Productions and Attractions command bar. This will tell TransCAD to use the 

NCHRP 365 Trip Generation method to convert your Boston-area population and employment 

forecasts into home-based work trip productions and attractions. It will also ensure that the 

number of productions exactly equals the number of attractions. 
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7. The NEMR TD&I Model will automatically save the results of the Trip Generation step to 

the Boston- area Trip Generation Productions and Attractions Output file. (Optional): If you 

also want to copy the results to a location where they can be independently accessed, click on 

the Copy P&A File to External Location command bar, and then follow the appropriate 

prompts to name and save your file. 
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3. Trip Distribution Steps 

8. Click on the GENERATE MINIMUM PATH menu tab. This set of procedures will create a 

set of minimum path “skim trees” consisting of the minimum time or distance path between 

every origin and destination zone in your study area. As currently implemented, all NEMR 

TD&I Model minimum paths are based on highway travel times and/or distances. For this 

example, we will allow two-way travel on all highway links, not impose any turn penalties, 

and keep track of the minimum time path in minutes. 

► Choose “Yes” to the Ignore Link Direction option◄ 

► Choose “Yes” to the Keep Duplicate Links option ◄ 

► Choose “Yes” to Turn Penalties ◄ 

► Choose “Minutes” as your Time Unit ◄ 
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► Choose “Shortest Time” as your Minimum Path Metric ◄ 

9. In the Highway Network Selection box, choose “Study Area Highway Network” to indicate 

that you will be using the Boston area highway network to build the minimum path skim 

trees. 

☼ Alternately, if you would prefer to use an alternative highway network to construct your 

minimum paths, choose the “User Network Option”, and then click on the Get User 

Highway Network Files to indicate the appropriate file path where your network can be 

found. Note that any user-specified networks must reference the same traffic analysis zone 

(TAZ) numbers as the default Boston study area highway network.. 

10. Review all your selections to make sure they are correct, and then click on the Generate 

Minimum Paths command bar to generate a full set of highway minimum paths. Note that 

this process may take some time to complete. 

11. (Optional): If you want to copy the set of minimum paths to an external file location, click on 

the Copy Minimum Path File to External Location command bar, and then follow the 

appropriate prompts to name and save your file. Make a note of the location of your exported 

file. 

12. You should now be ready to run the Trip Distribution procedure. This procedure uses a 

gravity model to connect trip productions and trip attractions to form a set of complete trips 

for every origin and destination pair in your study area. 

13. Click on the TRIP DISTRIBUTION menu tab. 

14. In the Choose Trip Purpose box, choose which trip purpose you will use the gravity model to 

create a trip table for. ► In the current case, choose “HBW” to indicate you will be creating 

a trip table of Home-based Work trips. ◄ 

15. The Confirm Input File Locations box allows you to choose which trip productions and 

attractions and which minimum path skim trees you will use as input into the gravity model. 

► Choose “Use Default Study Area File Locations” to indicate you will be using the 

Boston area productions and attractions file and minimum path files developed in the 

previous steps ◄. 
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☼ If instead of the default Boston area productions and attractions and minimum path files 

generated in the previous steps, you wish to use your own, choose “User P&A File” and/or 

the “User-generated Minimum Path Files.” Then, depending on which options you chose, 

click on the Get User Production & Attractions File command bar and/or the Get User-

generated Minimum Path command bar. Note that the Trip Distribution process will only 

work properly if your user-generated files have the same zone and variable structure as the 

default Boston area files. 

16. Review all your selections to make sure they are correct, and then click on the Create 

Total Trip Table command bar to run TransCAD’s Trip Distribution procedure. Note that this 

process may take some time to complete. 

17. (Optional): If you want to copy the total trip table to an external location, click on the Copy 

Total Trip Table to External Location command bar, and then follow the appropriate 

prompts to name your file. Make a note of the location of your exported file. 
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4. Mode Share Calculations 

18. Click on the MODE SHARE menu tab. This set of procedures will all allow you to apply a 

series of mode share percentages to the total trip table created in the previous Trip 

Distribution step to generate a series of mode-specific trip tables. Depending on the study 

area, these mode share percentages are derived either from the 2017 National Household 

Travel Demand Survey or from travel surveys administered by local metropolitan planning 

organizations (MPOs). 

19. In the Choose Mode box, click on the mode you wish to develop the trip table for. ► In the 

current case, choose “Metro Area Bus” ◄ Note that you can only develop one modespecific 

trip table at a time. 
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☼ The NEMR TD&I Model also gives users the option to import their own mode share tables 

or to modify an existing mode share table by increasing all the mode share percentages by a 

fixed amount. To import your own mode share table, click on the Import User Mode Share 

Table command bar and locate the table you wish to import. 

20. In this example, we will be increasing the share of commuter bus trips by 50% above their 

default values. Note that you can also choose to decrease your trip shares. 

► In the Modify Existing Mode Share Table box, choose the percentage you wish to increase 

the current mode share percentage by. In the current example, choose “50%” ◄ 

► Then choose “Increase mode shares” ◄. 

This will have the effect of increasing the current commuter rail mode share by 50% for all 

origin destination pairs. So, for example, if the current commuter rail mode share between an 

origin-destination pair is 10%, increasing it by 50% will bring the commuter rail mode share 

up to 15% (10% * (1+50%)). Note that this will not affect the mode share of any other mode. 

21. Review all your selections to make sure they are correct, and then click on the Calculate 

Modal Trips command bar to calculate a trip table for your mode of choice. This is the trip 

table you will allocate to a route in the next step. 

22. (Optional): If you want to copy the modal trip table to an external location (for later use, or so 

that you can generate a mode trip table for a different mode or purpose), click on the Copy 

Modal Trip Table to External Location command bar, and then follow the appropriate 

prompts to name your file. Make a note of the location of your exported file. 

5. Trip and Route Assignment 
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23. Click on the TRAFFIC & ROUTE ASSIGNMENT menu tab. This set of procedures will 

allow you to allocate the highway, rail, and bus trips generated by the Mode Share Calculator to 

particular highway, rail, and bus links routes. The current version of the 

NEMR TD&I Model is limited to an “all-or-nothing assignment,” meaning that all trips are 

assigned to the shortest route regardless of congestion levels or available capacity. Users 

wanting to use a different route assignment method should do so in TransCAD. Unless 

otherwise indicated, all trip assignments cover a 24-hour period. Note that the MAC Model 

options do NOT give you the option of adding truck trips to your highway assignments. 

24. In the Confirm Modal Trips to Assign to Routes box, you can choose either the Default 

Option to indicate you will be using the modal trip table calculated in the previous Mode 

Share step, or the Import User Modal Trip Table to indicate you will be using a different 

modal trip table. ► In the current case, choose “Default” to indicate you will be using modal 

trip table created in Step 23. ◄ 
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☼ If instead of the Default Option you had chosen to import a modal trip table of your own, 

you would now click on the Import User Modal Trip Table command bar. 

25. Because the MAC Models do not allow users to allocate truck trips to highway links along 

with car trips, skip over the Add Freight Trip Option, and click on the Allocate Trips to 

Routes command bar. TransCAD will then begin the route allocation process, which, 

depending on the size of your study area and highway or networks, may take several minutes. 

Currently, the only available assignment method is “all or nothing,” meaning that all trips are 

allocated to the shortest highway path or transit route(s) regardless of congestion levels or 

available capacity. 

26. The NEMR TD&I Model gives users the option of preparing and saving multiple route 

allocations and saving the results in a location of the user’s choice. Accordingly click on the 

Copy Route Assignment Results to External Location command bar and choose the file 

location where you wish to save your route assignment results. Make a note of this location. 

27. You have now completed a run of the NEMR TD&I Boston MAC Model. 

CONGRATULATIONS! 

28. To allocate a different set of modal trips to a highway or transit network, go back to Step 19 

and begin the mode share calculation and route assignment procedures anew. Note that these 

additional model runs may overwrite some of your previous files, so be sure to specify 

different File Export locations for your new runs. 

6. Displaying Your Bus Route Assignment Results in TransCAD 

31. Minimize the GISDK window in which you are running the NEMR TD&I Model. Maximize 

the TransCAD interface window, and click on File Menu: 
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► Open the Boston bus network map file (BOSBus.dbd) in TransCAD. ◄ 

► Locate and open the Traffic Assignment table you saved in Step 27 

(40BOSHBWbus.bin) ◄ 

32. Click on the TransCAD View Menu and make the Streets Map file your primary TransCAD 

window. 

33. Click on the TransCAD Planning Menu and choose Assignment Utilities > Create Flow 

Map: 

► For the Line Layer, select the Street Map file (BOSBus) opened in Step 31, above ◄ 

► For the Flow Table, select the Traffic Assignment table (40BOSHBWbus.bin) opened in 

Step 31 ◄ 

► For the Flow Field, select the appropriate the Total Flow field (from Traffic 

Assignment table), most likely Tot_Flow◄ 

► For the V/C Field, select None (optional if V/C Field has been calculated by user) ◄ 

34. Click on OK to display your Route Assignment Flow Map. It will look something like the 

map below. The line colors and labels can be edited using the Display Manager and Map 

toolbars provided within the TransCAD user interface. Additional line layers can also be 

added to this flow map using the TransCAD interface. In the example below, the Bus routes 

have been adjusted to a dark red. The varying line thicknesses reflect passenger usage across 

different bus links. An additional background line file (BOSMACZones.dbd) has been added 

as a Map Layer for context. The gray opaque fill and thin black boundary linestyles are 

selected as Display Manager options. 
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